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1. Introduction to Kernel for MBOX to PST 

Welcome to the User Manual of Kernel for MBOX to PST, an effective and powerful email migration tool to 
convert MBOX files into MS Outlook PST or MSG file format. This user manual comprises step-by-step 
guidelines on using Kernel for MBOX to PST software. 

 

1.1 Using this Manual 

This User Manual is intended to guide users on using Kernel for MBOX to PST. We suggest that first time 
users should read this User Manual completely and carefully before proceeding to use the software. 
However, if you are an experienced user, you can use the Table of Contents to find out information 
pertaining to the tasks that you need to perform by using Kernel for MBOX to PST. 

You can use the Table of Contents to navigate through different sections of this User Manual. The Table 
of Contents enlists all the sections contained within this user manual in chronological order. This User 
Manual comprises following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Using Kernel for MBOX to PST 

 Full Version 

 Support  

 Troubleshooting  

 Legal Notice 

 

1.2 About Kernel for MBOX to PST 

Kernel for MBOX to PST is an advanced and professional email migration software that facilitates 
migrating MBOX files created with numerous email clients including AppleMail, Entourage, Eudora, 
Postbox, Netscape, PocoMail, Thunderbird, Spicebird, Opera, PowerMail, Claws Mail, Evolution, 
SeaMonkey, Sylpheed, Mulberry, GyazMail, Gnu, Sparrow, and The Bat! into easily accessible Microsoft 
Outlook .PST or .MSG file formats. Enriched with powerful email migration algorithms, Kernel for MBOX to 
PST software efficiently converts MBOX files to PST or MSG files. 
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Using Kernel for MBOX to PST, all the mailbox folders contained within the MBOX files including Inbox, 
email attachments, sent items, drafts, junk folder, deleted items folder, etc. are accurately converted into 
PST or MSG format. While performing the email migration, the software preserves the original MBOX file 
data along with its structure and properties. The software facilitates adding multiple MBOX files at once by 
using ‘Add Files’ button along with option to add an entire disk or folder using ‘Add Folder’ button. The 

software facilitates preview of added MBOX files before saving and allows saving converted emails in 
folder hierarchy. 

Offered easy-to-use, self-descriptive, user-friendly Graphical User Interface of Kernel for MBOX to PST 
makes the entire email migration process a much easier task even for novice users. Available free to 
download trial version lets users evaluate its capabilities before purchasing the full licensed version. 

 

1.3 Salient Features 

Salient features of Kernel for MBOX to PST include:  

 Efficiently converts MBOX files to PST or MSG file format 

 Accurately converts emails, attachments, sent items, deleted items folder, etc. from MBOX files to 
MS Outlook PST or MSG files 

 Allows filtering MBOX files on the basis of To, From, Subject, and Date fields 

 Facilitates filtering and saving specifically those files containing attachments 

 Supports conversion of Unicode characters 

 Allows saving converted emails in folder hierarchy 

 Displays preview of added MBOX files before saving them to either PST or MSG file formats 

 Offers option to add entire drive or folder of MBOX files for conversion at once using ‘Add Folder’ 
button 

 While saving in PST file format, the tool offers option to save the converted file either into a newly-
created PST file or an already-existing PST file 

 Keeps the original structure, formatting and properties of the mailbox items unhampered 

 Designed in an extremely user-friendly, self-descriptive, highly-interactive GUI 

 Supports conversion of MBOX files created with AppleMail, Entourage, Eudora, Postbox, 
Netscape, PocoMail, Thunderbird, Spicebird, Opera, PowerMail, Claws Mail, Evolution, 
SeaMonkey, Sylpheed, Mulberry, GyazMail, GNUMail, Sparrow, and The Bat! email clients 
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 All the supported email client versions must support MAC OS X, UNIX, and Windows OS 

 Works well with MS Outlook 2000, 2002, 2003, 2007, 2010, and 2013 versions 

 Works well with Windows XP, Windows Vista, Windows 7, Windows 8, Windows Server 2000, 
Windows Server 2003, Windows Server 2008, Windows Server 2008 R2, and Windows Server 
2012 Operating System platforms 

 Available as a free to download evaluation version 

 Offers round-the-clock technical support 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for MBOX to PST, you are ready to get 
a hand on experience of the software. To start converting MBOX files into PST or MSG format, you will 
first need to download and install this software. 

It is strongly recommended that before installing Kernel for MBOX to PST, you should go through the 
installation pre-requisites for the software to ensure that your computer is appropriately configured to run 
the software. 

 

2.1 Installation Pre-requisites 

Following are the basic system pre-requisites in order to perform successful conversion of MBOX files to 
MS Outlook PST or MSG files using Kernel for MBOX to PST software: 

Minimum System Requirements:  

 Pentium Class Processor  

 64 MB RAM (128 MB Recommended)  

 10 MB for Software installation  

 Disk Space - Enough space to save the results  

 

Supported MS Windows Operating System (Both 32-bit and 64-bit): Windows XP, Windows Vista, 
Windows 7, Windows 8, Windows Server 2000, Windows Server 2003, Windows Server 2008, Windows 
Server 2008 R2, and Windows Server 2012 

 

Supported MS Outlook versions (Both 32-bit and 64-bit): MS Outlook 2000, MS Outlook 2002, MS 

Outlook 2003, MS Outlook 2007, MS Outlook 2010, and MS Outlook 2013 

  

Supported Email Client versions: 

 AppleMail: AppleMail 2, 3, 4, 5, 6 and 7 versions  

 Entourage: Entourage 2004 and 2008 versions  
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 Eudora: Eudora 6.0.1, 6.2, 7.0 and Eudora OSE  

 Postbox: All versions  

 Netscape: Netscape series of suites between 4.5 to 7.2 versions  

 PocoMail: PocoMail 4.8 and all latest versions  

 Thunderbird: Thunderbird to Thunderbird 16 and other latest versions  

 Spicebird: Spicebird 0.4, 0.8 and other latest versions  

 Opera: Opera M2, 9.5, 10, 11, 12.10, 12.11 and other latest versions  

 PowerMail: All versions  

 Claws Mail: All versions  

 Evolution: All versions  

 SeaMonkey: All versions  

 Sylpheed: All versions  

 Mulberry: All versions  

 GyazMail: All versions  

 Gnu: All versions  

 Sparrow: All versions  

 The Bat!: All versions 

 All the above-mentioned email client versions must support MAC OS X, UNIX, LINUX, and 

Windows OS 

 

2.2 Downloading Kernel for MBOX to PST for the First Time 

After checking your computer with the prescribed system requirements for Kernel for MBOX to PST, you 
can download the evaluation version of the software on your computer using the following link: 

http://www.nucleustechnologies.com/download-mbox-to-pst-conversion.html 

http://www.nucleustechnologies.com/download-mbox-to-pst-conversion.html
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 The free trial version of Kernel for MBOX to PST accurately converts MBOX files to PST or MSG 
format but allows saving only 25 items per MBOX file. To save entire converted items, purchase 

the full version of the software. 

 

2.3 Install Kernel for MBOX to PST 

To install Kernel for MBOX to PST onto your computer system, perform the following steps:  

1. First make sure that the host computer meets the entire basic system requirements and has 
sufficient memory available. 

2. Download Kernel for MBOX to PST software from the website: 

www.nucleustechnologies.com/mbox-to-pst.html 

3. Double-click the Kernel for MBOX to PST software Installer .exe file. 

4. Follow the on-screen instructions. The setup install completion screen will be displayed. 

5. Click Finish, the main window of the Kernel for MBOX to PST software will be launched. 

 

2.4 Start Kernel for MBOX to PST 

To start Kernel for MBOX to PST software: 

Click Start  All Programs  Kernel for MBOX to PST  Kernel for MBOX to PST 

Alternatively, you can launch Kernel for MBOX to PST by double-clicking the shortcut icon available on 
the desktop or the Quick Launch icon. 

 

2.5 Uninstall Kernel for MBOX to PST 

Kernel for MBOX to PST can be uninstalled from the computer system in two ways: 

 From the Windows Start menu  

 From the Control Panel  

 

Uninstall from the Windows Start Menu: 

http://www.nucleustechnologies.com/mbox-to-pst.html
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1. Click the Start button from the Windows menu.  

2. Click All Programs > Kernel for MBOX to PST > Uninstall Kernel for MBOX to PST.  A warning 
message before uninstalling the software will be displayed on the screen.  

3. Click Yes to uninstall the software. 

Kernel for MBOX to PST will be successfully uninstalled from your computer system. 

 

Uninstall from the Control Panel: 

1. Click the Start menu > Control Panel and then double-click the Add or Remove Programs icon. 

2. Select the Kernel for MBOX to PST software and click Remove. A warning message before 
uninstalling the software will be displayed on the screen.  

3. Click Yes to uninstall the software.  

Kernel for MBOX to PST will be successfully uninstalled from your computer system. 

 

3. Software Interface 

Now that Kernel for MBOX to PST has been installed on your computer, you can start using the software 
after getting acquainted with the software interface. 

 

3.1 Welcome Screen of Kernel for MBOX to PST 

Kernel for MBOX to PST offers user-friendly and self-descriptive graphical user interface. When the 
software is launched, following main screen of the software appears: 
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Figure 3.1: Welcome Screen of Kernel for MBOX to PST 

 

3.2 Menu Bar 

      The Menu bar of Kernel for MBOX to PST comprises three menus: 

 File Menu 

 View Menu 

 Help Menu 
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File Menu 

The File menu of Kernel for MBOX to PST software appears, as shown in the following figure: 

 

Figure 3.2: File Menu 

Following table enlists the options available in the File menu: 

Option Description 

Select Click to select a email client among 19 supported email clients 

Save Click to save the converted files in PST or MSG file format 

Exit Click to exit from the application 

 

View Menu 

The View menu of Kernel for MBOX to PST software appears, as shown in following figure: 

 

Figure 3.3: View Menu 

Following table enlists the option available in the View menu: 

Option Description 

Status Bar Selecting this option displays the status bar 

 

Help Menu 

Help menu of Kernel for MBOX to PST software appears, as shown in following figure: 

 

Figure 3.4: Help Menu 

Following table enlists the options available in the Help menu: 
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Option Description 

About Click to view details about the software 

Software Help Click to view the help file of the software 

 

3.3  Tool Bar 

The Tool Bar of Kernel for MBOX to PST displays three buttons: Select, Save and Help. Almost all 

functions of Kernel for MBOX to PST can be performed using the tool bar. It offers the convenience of 
being user-friendly. Various buttons of the tool bar are described below in detail: 

 

Button Description 

 

Option to select the email client among 19 email clients 

 

Option to save the converted files in PST or MSG file format 

 

Option to open the help file of the software 

 

3.4 Buttons Used 

The GUI of Kernel for MBOX to PST consists of several buttons that has a key role while converting 
MBOX files to MS Outlook PST or MSG files. Following table enlists the various buttons used in the 
software: 

 

Button Description 

 

Adds a single or multiple MBOX file(s) from a known location 

 

Adds multiple MBOX files from a folder or a selected drive 

 

Removes selected MBOX file(s) 

 

Adds defined filter in the list 
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Removes defined filter(s) from the list 

 

Saves the converted files to PST or MSG file format 

 
Click to provide the destination location for saving the converted PST file 

 
Navigates the user to the previous window 

 
Navigates the user to the next window 

 
Exits from the application 

 
Closes the software after process completion 
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4. Using Kernel for MBOX to PST 

4.1 Adding MBOX Files 

Kernel for MBOX to PST is an eminent email migration utility that allows migrating MBOX files to PST or 
MSG file format that can be easily accessed with MS Outlook. Follow the steps given below to perform 
accurate conversion from MBOX files to PST or MSG files:  

1. Launch Kernel for MBOX to PST. The following main screen of the software appears: 

 

Figure 4.1: Main Screen of Kernel for MBOX to PST Software 
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Among the enlisted 19 email clients on the main screen of the software, user can select any one of them in 
order to perform required email conversion. After selecting an email client, user needs to add MBOX file(s) 
to be converted. The AppleMail email client is selected by default as the software is launched and in this 
user guide the conversion of AppleMail MBOX files to MS Outlook PST or MSG files is explained.  

2. After selecting AppleMail email client, click Next to proceed further. The following screen appears: 

 

Figure 4.2: Add File(s) Option 

Here, user can either click Add File(s) button to add single or multiple MBOX file(s) for conversion (in case 
the location of MBOX file(s) is known to the user) or can click Add Folder button to specify the drive or 

folder for adding the MBOX files. 

3. Click on Add File(s) button and add the MBOX file(s) that needs to be converted. After adding MBOX 
file(s), the screen appears as: 
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Figure 4.3: Added MBOX Files 

After adding multiple MBOX files user might require to remove some of the added MBOX files. This can be 
easily done by selecting the files that needs to be removed from the list: 
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Figure 4.4: Selecting MBOX file(s) for removal 

Click on Remove File(s) button to remove the selected MBOX File(s). After removing selected MBOX 

files, the screen appears as: 
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Figure 4.5: MBOX files after removal 

 

4.1.1 How to add MBOX Files using ‘Add Folder’ option 

Kernel for MBOX to PST allows adding MBOX files from an entire folder at once or a disk drive in case the 
location of MBOX files is not known to the user. Follow the below given steps to add MBOX files using 
Add Folder button: 

1. Click on Add Folder button to add single or multiple MBOX file(s) from a folder or a disk drive. 
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Figure 4.6: Add Folder Option 

 

2. Select the folder containing the MBOX files: 
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Figure 4.7: Selecting Folder containing MBOX files 

 

The software starts enumerating folders as: 
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Figure 4.8: Enumerating Folders 

 

4.1.2 Preview Functionality 

On clicking the Finish button, Kernel for MBOX to PST allows its users to have a complete preview of all 

the added MBOX files' email items before saving them either to PST or MSG file format: 
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Figure 4.9: Preview of Added MBOX files 

 

4.2 Saving added MBOX Files 

Click on the Save button from the tool bar or from File menu  Save to save the added MBOX files. The 
following window appears for defining the conversion rules for converting the email items: 
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Figure 4.10: Conversion Options 

Here, user can either select "Convert all items" to convert all email items without defining any conversion 
rule or can select "Define conversion rule" to set the filter criteria. 

Let's here we define the filter criteria for email conversion by selecting the "Define conversion rule" 
option. In the Where field, four options are available - From, To, Subject and Date. 
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Figure 4.11: Filtering Options 

 

 

From Field: In this field, user can specify a value that is either contained or is not contained in the ‘From’ 

attribute of the email item. 
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Figure 4.12: Defining ‘From’ Filter 

Specify a value that is contained within ‘From’ field. Click Add button to add the filter criteria to the list. 

 

To Field: Similar to the ‘From’ field, user can also provide the required specifications in the ‘To’ field. 
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Figure 4.13: Defining ‘To’ Filter 

 

Subject Field: In the similar manner, user can also provide value for ‘Subject’ field: 
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Figure 4.14: Defining ‘Subject’ Filter 

 

Date Field: In this field, user can specify the date range in the ‘From’ and ‘To’ fields: 
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Figure 4.15: Defining ‘Date’ Filter 

 

After specifying all the filtering criteria, the window appears as: 
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Figure 4.16: Defined Conversion Criteria 

 

After defining the filtering criteria, user can even remove a defined filter by simply selecting it and clicking 
the Remove button: 
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Figure 4.17: Removing a defined Conversion Criteria 

 

After defining the conversion rules, user can even select the "Attachments" checkbox to convert all the 
email items along with attachments. Click Next to proceed. 

Kernel for MBOX to PST allows saving converted MBOX files into PST or MSG file formats that can be 
easily accessed with MS Outlook email client. While saving in PST file format, Kernel for MBOX to PST 
offers two different options: 

 Create New PST File 

 Save in Existing PST File 

Furthermore, Kernel for MBOX to PST allows saving converted email items according to folder hierarchy. 
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4.2.1  Create New PST File 

After defining the conversion rules on MBOX files, the software allows user to save it in a newly-created 
PST file by following the steps as given below: 

1. Select "Create New PST File" option: 

 

Figure 4.18: Saving data in a new PST File 

2. Click Browse button to provide the destination of newly-created PST File. The software creates a new 

PST File with a default name KernelMBoxToPST.PST as: 
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Figure 4.19: Newly-created PST File with a default name 

 User can edit the default name of newly-created PST file 
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Figure 4.20: Editable newly-created PST File name 

3. Click Save button to save the converted email items in newly-created PST file. The software starts the 

conversion process from MBOX to PST as follows: 
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Figure 4.21: Saving in Progress 

4. After successful completion of email conversion process, the newly-created PST file gets stored at the 
specified location as: 
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Figure 4.22: Successful Saving of new PST File 

 

4.2.2 Save in Existing PST File 

Kernel for MBOX to PST also facilitates its users to save the converted MBOX file in an already-existing 
PST file. For saving the converted MBOX files into an already-existing PST file, follow the steps as given 
below: 

1. Select "Save in Existing PST File" option. Click Browse button to provide the location of an already-

existing PST file. The specified PST file gets enlisted as: 
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Figure 4.23: Specifying Existing PST File Path 

2. Click Save button to save the converted email data in an already-existing PST file. The software 

displays the conversion process as: 
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 Figure 4.24: Saving in Existing PST File in Progress 

3. After successful completion of the conversion process, the software displays the location of PST file 
where it get saved. 
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Figure 4.25: Successful Saving in Existing PST File 

 

 

4.2.3 Save in MSG File 

Kernel for MBOX to PST allows saving converted MBOX files into MSG file format as well that can be 
easily accessed with MS Outlook email client. For saving the converted email items in MSG file format, 
follow the steps as given below: 

1. Select "Save in MSG" option: 
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Figure 4.26: Save in MSG Option 

2. Click Browse button to provide the destination of MSG file. Here, user can select the "Save in folder 
hierarchy" option as well: 
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Figure 4.27: Providing Destination to save MSG File 

3. Click Save button to save the converted email items in MSG file format. The software displays the 

conversion process as: 
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Figure 4.28: Saving in MSG in Progress 

4. After successful completion of saving progress, the software displays successful saving message as: 
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Figure 4.29: Successful Saving of MSG File 
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5. Download Purchase and Register 

5.1 Free Trial Download 

Kernel for MBOX to PST is available as an evaluation version for free that allows users to analyze its 
features and functionalities before deciding to purchase the licensed version of the software. The free trial 
version works almost similar to that of the full version but has a limitation that it allows saving only 25 
items per MBOX file. To save all the converted items, user must purchase the full licensed version of the 
software. 

Free version of Kernel for MBOX to PST can be downloaded from our website: 

www.nucleustechnologies.com/download-mbox-to-pst-conversion.html (encrypted and secure site) 

 

5.2 Purchase & Register 

Purchase the full version of Kernel for MBOX to PST software for saving the entire converted items from 
MBOX files to MS Outlook PST or MSG files. The FREE trial version of Kernel for MBOX to PST software 
allows saving only 25 items per MBOX file.  

You can purchase the Full version of Kernel for MBOX to PST software through our website: 

www.nucleustechnologies.com/buy-mbox-to-pst.html (encrypted and secure site) 

 

Payment and Delivery 

Purchase the Kernel for MBOX to PST software from our authorized resellers, which provide number of 
payment options for your ease - PayPal, FAX, Credit Card, E-cheque, Pay Order, etc. 

After making the purchase transaction with our resellers, an email is sent consisting of activation details 
and download link of the Full version of Kernel for MBOX to PST comprising of the activation code. This 
email is sent to the email address, which you have used while processing the purchase transaction with 
our resellers. 

We suggest you not to use false e-mail address while making the purchase transaction. 

For any other details related to purchase process, software activation process, email us 
at: sales@nucleustechnologies.com 

 

5.3 Support 

Lepide Software Pvt. Ltd. provides round-the-clock technical support for its product range to solve 
technical and software queries. The software comes with an embedded help manual that can be accessed 
by clicking Help in the software main window. You can also press the F1 key on the keyboard of your 

computer to access the embedded help manual of Kernel for MBOX to PST. 

http://www.nucleustechnologies.com/download-mbox-to-pst-conversion.html
http://www.nucleustechnologies.com/buy-mbox-to-pst.html
mailto:sales@nucleustechnologies.com
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You can access the online user guides for Kernel range of softwares 
at: www.nucleustechnologies.com/Online-Helps.html  
 
The Animated Demos for Kernel range of softwares can be easily accessed through: 
www.nucleustechnologies.com/Animated-Tours.html  

 

We also have live support wherein you can chat with our software experts 
at: www.nucleustechnologies.com/Support.html 

Telephone Support: 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

Email Support: 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Animated-Tours.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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6. Troubleshooting 

6.1 Common Issues 

What is the limitation in the trial version of Kernel for MBOX to PST? 

The trial version of Kernel for MBOX to PST works almost same as that of the full version of the software. 
The ‘Add Files’ and ‘Add Folder’ options works similar to that of the full version letting user add multiple 
MBOX files for conversion, displays preview of added MBOX files, converts them to PST or MSG format 
but restricts from saving only 25 items per MBOX file. To save entire converted items of MBOX files, user 
must purchase the full licensed version of the software. 

 

6.2 Frequently Asked Questions 

1. How to purchase Kernel for MBOX to PST? 

One can buy Kernel for MBOX to PST using the website:  

www.nucleustechnologies.com/buy-mbox-to-pst.html 

2. What are the different saving options offered by Kernel for MBOX to PST? 

Kernel for MBOX to PST allows saving MBOX files in PST or MSG file format. While saving in PST format, 
user can save in a new PST or an already existing one. 

3. What are the supported Windows OS platforms for Kernel for MBOX to PST software? 

The supported Windows OS platforms for Kernel for MBOX to PST software are: Windows XP, Windows 
Vista, Windows 7, Windows 8, Windows Server 2000, Windows Server 2003, Windows Server 2008, 
Windows Server 2008 R2, and Windows Server 2012 

4. What are the supported MS Outlook versions for Kernel for MBOX to PST software? 

The supported MS Outlook versions for Kernel for MBOX to PST software are: MS Outlook 2000, MS 
Outlook 2002, MS Outlook 2003, MS Outlook 2007, MS Outlook 2010, and MS Outlook 2013 

5. Give the link for downloading the free trial version of Kernel for MBOX to PST software. 

The free trial version of Kernel for MBOX to PST software can be downloaded using the link: 

www.nucleustechnologies.com/download-mbox-to-pst-conversion.html 

 

http://www.nucleustechnologies.com/buy-mbox-to-pst.html
http://www.nucleustechnologies.com/download-mbox-to-pst-conversion.html
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7. Legal Notices 

This section comprises the legal specification about Kernel for MBOX to PST and the company Lepide 
Software Private Limited. 

 

7.1 Copyright Notice 

Lepide Software Private Limited, Kernel for MBOX to PST, accompanied user manual, and 
documentation are copyright of Lepide Software, with all rights reserved. Under the copyright laws, this 
user manual cannot be reproduced in any form without the prior written permission of Lepide Software. 
No Patent Liability is assumed, however, with respect to the use of the information contained herein. 

© LEPIDE SOFTWARE PVT LTD. All rights reserved. 

 

7.2 Trademarks 

Kernel for MBOX to PST® is a copyright work of Lepide Software Private Limited. 

Windows 8®, Windows 7®, Windows Vista®, Windows XP®, Windows Server 2000®, Windows Server 
2003®, Windows Server 2008®, Windows Server 2008 R2®, and Windows Server 2012® are registered 
trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective 
companies. 

 

7.3 Disclaimer 

The information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. Lepide Software Private Limited provides no warranty with regard to this manual 
or any other information contained herein and hereby expressly disclaims any implied warranties of 
merchantability or fitness for any particular purpose with regard to any of the foregoing. Lepide Software 
Private Limited assumes no liability for any damages incurred directly or indirectly from any technical or 
typographical errors or omissions contained herein or for discrepancies between the product and the 
manual. 

In no event shall Lepide Software Private Limited be liable for any incidental, consequential special, or 
exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with this 
manual or any other information contained herein or the use there of. 
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7.4 License Agreement 

Kernel for MBOX to PST© by Lepide Software Private Limited. 

 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing, or distributing this 
software, unless you have a different license agreement signed by Lepide Software Private Limited. The 
terms and conditions of this License describe the permitted use and users of each Licensed Copy of 
Kernel for MBOX to PST. For purposes of this License, if you have a valid license, you have the right to 
use a single Licensed Copy of Lepide. 

 

Scope of License 

Each Licensed Copy of Kernel for MBOX to PST may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in the Lepide, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by Lepide Software. You may not rent, lease, modify, translate, reverse 
engineer, decompile, disassemble, or create derivative works based on, Lepide, nor permit anyone else 
to do so. You may not make access to Lepide available to others in connection with a service bureau, 
application service provider, or similar business, nor permit anyone else to do so. 

 

Warranty Disclaimers and Liability Limitations 

Kernel for MBOX to PST, and any and all accompanying software, files, data and materials, are 
distributed and provided as is and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Kernel for MBOX to PST, must be thoroughly 
tested with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all 
use of the copies of Kernel for MBOX to PST covered by this License. This disclaimer of warranty 
constitutes an essential part of this License. In addition, in no event does Lepide Software authorize you 
or anyone else to use Kernel for MBOX to PST in applications or systems where Kernel for MBOX to 
PST Failure to perform can reasonably be expected to result in a significant physical injury, or in loss of 
life. Any such use is entirely at your own risk, and you agree to hold Lepide Software harmless from any 
and all claims or losses relating to such unauthorized use. 

 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements, and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third-party beneficiaries of any promises, 
obligations, or representations made by Lepide Software herein. Any waiver by Lepide Software of any 
violation of this License by you shall not constitute, nor contribute to, a waiver by Lepide Software of any 
other or future violation of the same provision, or any other provision, of this License. 


